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IMPORTANT

The Account Manager Program is copyright © Bill Weidenauer 1997
The Account Manager Manual is copyright © Creative Technology 1997

This package is published by Bill Weidenauer and Creative Technology
(MicroDesign) Ltd, hereafter referred to as "The Publisher".

Publisher’s Statement and Licence Agreement
The computer software product described in this manual is protected under
copyright law in the UK and in other countries. This copy of the software is
licensed to be used on one computer at a time only. Any unauthorised copying,
whether for resale or not, is strictly prohibited, with the sole exception that the
purchaser may make a secure back-up copy to protect against loss. SOFTWARE
PIRACY IS THEFT.
This package is subject to continuous development and improvement. This
manual is provided to you free of charge and is intended only to assist the reader
in the use of the product, and the information contained in this manual and
literature provided with the product is given by the Publisher in good faith.
Neither the whole nor any part of the information contained herein, nor the
products described in this manual may be adapted or reproduced in any material
form except with the prior written approval of the Publishers.
This manual may include technical inaccuracies or typographical errors. Changes
are periodically made to the information contained herein; these changes will be
incorporated in new editions of the publication. The Publisher may make im-
provements and/or changes in the product described in this publication at any
time but does not undertake to notify customers of these changes.
The Publisher makes no warranty of any kind, either express or implied, includ-
ing but not limited to the implied warranties of merchantability or fitness for a
particular purpose, and the Publisher accepts no liability for any loss or damage
arising from the use of any information provided or omitted.
The products referred to herein are not designed and should not be used for, or in
connection with, life critical functions or any activity in which an error or a fault
may result in physical damage or injury to person(s), and the Publisher does not
authorise such use.
Nothing in this document is intended to exclude or restrict any of the consumer’s
rights where to do so would be illegal.

Creative Technology (MicroDesign) Ltd
Park House, Park St, Uttoxeter, Staffs ST14 7AG
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INTRODUCTION

What is Account Manager?
Account Manager is a simple program which allows you to keep track of your
personal finances on your PcW16, using a screen display which works very much
like a standard bank statement. If you enter all your account deposits and
withdrawals into the program, it allows you to check your real bank statements,
and keep track of different categories of earnings and expenditure.

Getting Started
The most important step when you buy any new PcW16 program is to make a
working copy of the program disc. This is important, because the disc you
normally use for starting the program will normally live somewhere near your
workspace, and may eventually be damaged, perhaps by something as simple as
a coffee spillage. We therefore recommend that you should not run the program
from the original or “master” disc every time, but have a spare copy of the master
for everyday use, and keep the master in a safe place. You will need a spare
floppy disc on which you can make the copy, and this disc must be Formatted
before you use it. You can format a disc in the PcW16 File Manager, using the
Format command in the Disc menu.
You can make a copy of the Account Manager master disc using the File Man-
ager program, which you can select from the PcW16 Desktop. From the Desk-
top, press the F6 key, which is also labelled File Manager. Once in the File
Manager program, you should see the word Disc in the menu bar across the top
of the screen - click on this word, and the Disc menu will drop down. Next, click
on the Duplicate Disc command, insert the master Account Manager disc, and
click OK. The program will read information from the disc, and after a while, it
will ask you to Insert the disc you want to copy ONTO - this means the spare
disc. Carry on swapping the discs as instructed until the program reports that the
copy is complete.
Once the copy is complete, store the original disc in a safe place, and label the
copy as a Working Copy. You can then use the working copy to run the pro-
gram, and if it becomes faulty, you can make another one from the safely-stored
master disc.
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Running Account Manager
Whether you want to run Account Manager from the Cabinet or from floppy
disc, the first time you run the program, you should run it from the floppy disc
copy you have made (see Getting Started above).
To run Account Manager for the first time, insert your copied disc, and choose
Run External Program from the Tasks menu. Next, click on the Disc selector -
you will see the Account Manager program appear:

then pres

When the Account Manager program name is highlighted, click OK to start the
program.

Floppy Disc and Cabinet
When using the Account Manager program, you can choose to use it entirely
from floppy disc as described above, or you can “install” the program in the
PcW16’s Cabinet memory using the Install to Cabinet command (see page 21).
Although it is more convenient to run programs from the Cabinet, space in the
Cabinet is limited, so if you want to keep this space free for other uses, you
should run the Account Manager program from floppy disc.

Using The Program - A Beginner’s Guide
This section describes how to start entering your bank account into the Account
Manager program.
When you start Account Manager for the first time, the program asks you if you
want to create a new yearly account file. You can create as many files as you
wish - for the moment, click YES to start. Once you have told the program to
start a new account, you will see the main program screen, as shown opposite:
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Iasks File Edit Options Chegue=-Book 1997 Undn Hi

To Add BLUE To Edit
a new antry the selected entry

Click Here or Press Click Here or Press

Prass [BLUE) to Add a trangactlon or press (YELLOW] to EdLt or (RED] to delate the selscted trangaction.

Like other PcW16 programs, Account Manager has a menu-bar, providing access
to menus of commands. The four large buttons below the menu-bar are similar
to those used in the PcW16's Diary, Address Book and File Manager programs -
they are used to select some of the most commonly-used commands in the
program, including a standard STOP button, which exits the program and returns
you to the main PcW16 Desktop.

The main screen area show the list of transactions in the account, but as this is a
new account, there are no transactions to show, and the list displays "No En-
tries"

Your First Transaction - Entering a Starting Balance
This section guides you through the process of creating a new account. Before
entering your real bank account information, try working through this example
using made-up information. It does not matter what information you enter at this
stage, because the example is just to let you practise using the program.
When you first create an Account Manager file, as you are doing at the moment,
you must begin by entering a “Starting Balance” to represent the amount of
money in the computerised version of the account when you start it. This initial
sum will be a “deposit” transaction, marked as “Carried Forward”.
All transactions are entered using the Add New Transaction command, which
can also be accessed by pressing the Blue key. So press Blue, or click on the
Add New Entry button.
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You will now see this dialog, which indicates all the information you can enter
about this transaction:

VBD DEPOSIT

et data b all fiplds |||-|.|-||-.-. W Ll

10 /03 /1997 |

IMPORTANT NOTE: As with any PcW16 dialog, you can alter settings
and enter information by clicking on the different parts of the dialog
with the mouse, and in some cases, using the keyboard to type in
information. If you are unsure how to use Dialogs on your PcW 16, see
the “Using Dialogs " section on page 48 of the PcW16 manual for help.

The details you can enter for a Deposit Transaction are:

Number: this is used mainly for cheque transactions, as it allows you to store the
cheque number, or any other numbers or codes up to six characters long. You do
not have to use the Number facility, so leave it blank for now.

Category: your account can have up to 32 categories for Deposits and 32 for
Withdrawls, and you can choose your own names for them, but a few standard
categories are automatically included in any new account file. For now, because
the program knows that you are entering an initial balance, it automatically
chooses a category called “Carried Forward”, so you do not need to change it.
Date: the transaction date is set automatically to today’s date, but you can
change it if you want to enter a transaction which took place some time ago. For
this example account, you can leave it set to today's date, or change it if you
wish.

Memo: this is a way of adding your own short information note for each transac-
tion. A transaction memo can be up to 28 letters long. At this point, because the
program knows that you are entering Starting Balance, it automatically enters the
memo "Starting Balance" for you, but when entering most transactions, you
should type a Memo which tells you what the transaction is for.

Amount: the amount of the transaction must be a whole number of pounds or
pence - transactions cannot include fractions of a penny. Click on the box, and
enter an amount for your starting balance.

Received: this option is used to differentiate between payments which have been
scheduled or paid by cheque, and payments for which the funds have actually
been received, or cheques which have definitely cleared. For the moment,
because you are entering a starting balance, leave the Received option selected.
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Confirming the Information in the Dialog

When you have finished entering information in the dialog, press Green or click
Done to store the information you have entered. The dialog will now disappear,
and the main screen will show the new Starting Balance at the top of the Transac-
tion List, where it previously displayed the words "No Entries".

Adding a New Transaction
Now let us assume that you have paid a £50 electricity bill using a cheque, and
that you want to enter this transaction into the Account Manager program, so that
your on-screen bank balance is kept up to date.
To enter any new transaction, you need to click the Add New Entry button, or
press Blue. The program now asks you which type of transaction you are
entering:

Because this transaction is a cheque which you have written, you should select
the option for Cheque Withdrawal. The dialog also allows you to enter De-
posit transactions, and Other Withdrawal transactions - this last option is used
for transactions such as direct debits, debit card payments (eg Switch cards) or
cashpoint withdrawals.

When you have selected Cheque Withdrawal, click OK and you will see the
Add Transaction dialog again, but with different initial settings. You must now
use the dialog to enter the information for the new transaction you are adding.

BN o1 /03 /1997 [}

(Reassuring Note: the details you enter here can be changed later on if you wish.)
For a Cheque transaction, you should enter the Number of the cheque in the
Number box. The program automatically sets the number to 000001 the first
time you enter a cheque transaction - if the cheque you wrote is not numbered
000001, you should click on the Number box and enter the correct cheque
number. Once you have entered the number, all subsequent cheque numbers will

Amstrad PCWI16 Page 7



Account Manager

automatically be numbered to follow the first one, though you can alter the
numbers at any time.

The Category drop-list allows you to select a category under which the transac-
tion will be stored. If you click on the Category box (which currently shows the
category Cash), you will see the list of expenditure categories which are pre-
defined in the program:

I E T HE

i ettt B ottt Bt

Mortgage/Loans
Bills/Sarvices
Insurance

you wish - for example, you can use the Bills/Services category for all your bills,
or you could set up a specific category for electricity bills, another for telephone
bills, etc. See Categories on page 16 for more information about using and
changing categories. In this example, as this is an electricity bill, select the Bills/
Services category.

The Date will automatically be set to today’s date, but you can change it to
match the date on the cheque if this is different.

The Amount, in this case £50. Note that you only type the number, not the "£".
The Memo is provided for your own note about what the cheque is for. For
example, you might type “Electricity Bill" into this box..

The setting of the Received / Not Received option controls whether or not the
transaction is included in the Bank Balance, which is described in the next
section of this manual. Transactions are normally only marked as Received
when the money is actually debited from the account, or for deposit transactions,
when the deposited funds have cleared. For more information about the Re-
ceived setting, see Viewing the Bank Balance on page 12, but for now, click the
Received box.

So the final settings for your example transaction look like this:
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When you have set all the transaction details, click DONE or press Green to store
the transaction. The screen now displays the list of transactions, with the new
transaction added, and with a new balance figure:

" I
vmount | |!!I:'| Balance

Wil Number I. Date |:I -I,'|

D 01/03/1997 Starting Balance S 4200,00 200.00
nooonT o104 14997 Ell'lr_l.'i-lll} ".’Llnh-.' ull.l.'lr-.' -".ll_“!l 1'__.1_| L] ]

You can now carry on adding transactions, and as you do so, they appear in the
Transaction List. Note that Deposit transactions show the letter D in the far left
column, and that the Amount column shows a “+" sign for deposit transactions,

LL )

and a “-” sign for withdrawals.

Editing Transactions
As well as adding new transactions, you can also alter or delete the transactions
you have already entered. As an example, the illustration below shows an
account containing 13 transactions, and describes how to edit one of these - if
you want to practice using the edit command, you can use the same procedure to
edit the Electricity Bill transaction you just added to your own example account.

Jasks File Edit Options Cheque-Book 1997 Undo Help

. W 1o Add To Edit To Delote
S10P a now entry the selected antry the selected entry
Click Here or Prass Click Here or Press Click Here or Pross

SELECT A TRANSACTION TO EDIT OF DELETH
[P W T WO B0 00 B PR TV FURT TR LU B0 00 WD Vo L0 T U 0 Ay OO0 1WA 0 O YO O P (D TR v L e AL T
isaction trom the list and pre YVellow or Red

quinber : Dati
i
01/01/1997 Starting Balance
16/01/19397 Mortgage (5)
002030 16/01/1997 Credit Card Dec
002031 26/01/1997 Shopping
05/02/1997 Wages (5)
14/02/1997 Car Insurance (5)
002032 14, 02/1997 Credit Card Jan
2/1997 Mortgage (5

e e

T T EL

002033 24/02/1937 Shopping -85.94 433.45
28/02/1937 Nursery (5} -25.80 407.65
05/03/1997 Wages (5) +856.00 1263.65
14/03/1987 Car Insurance (5) =22.40 1241.25
14/03/1997 Credit Card Feb ~651.36 589.89

Press [BLUE] to Add a transaction or press [YELLO'W] to Edit or [RED] to delete the selacted transactlon.

The transactions list has a black highlight, which moves up and down as you
press the T\ keys. This highlight indicates the Current Transaction, and it is
used to select a transaction for Editing or Deleting. To Edit or Delete a particular
transaction, move the highlight over that transaction, then click the Edit or
Delete buttons.
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In this example, let us assume that the "Credit Card Jan" transaction highlighted
in the previous illustration was a payment by cheque, on February 14th, for a
credit card bill. This example assumes that the amount was entered incorrectly,
and needs to be changed. To alter a transaction, move the highlight over the
transaction using the T keys, then click the Edit button or press Yellow.

The screen now shows the details of the transaction as they were originally
entered, which in our example look like this:

DT WITHOE AW

You can now change any of the details for this transaction - in this example, we
need to enter the correct Amount, which (for the sake of example) we will say is
£235.34. So if you click on the Amount box, then type in the correct figure and
click Done, the main program screen will show the transaction with the cor-
rected amount, and a new balance figure:

Cheque-Book 1997

“ M To Delete ﬁ
- nmu entry thu uhmd entry the selected entry
Click I-I-r- or I'ﬂu Cllick Here or Press Click Heve or Press

16/01/1997 Mortgage (5)
002030 16/01/19397 Credit Card Dec
002031 26/01/1997 Shopping
05/02/1997 Wages (S)
14{1]2;1!!7 Car Innlrlnu 15)
12 14 :I 1 + l

21 !ll!.-" 1937 Shnpplnq
28/02/1937 Nursery (5)
05/03/1997 Wages (5)
14/03/1997 Car Insurance (5)
14/03/1997 Credit Card Feb

[ Prass [BLUE] to Add a transactlon or press [YELLOW] to Edit or (RED] to delate the selscted transaction,

You can use the same technique to alter the Memo, Number, Category, Date or
other details in any transaction you have entered.

Page 10
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Creating Multiple Account Files
The Account Manager program stores your accounts and transactions in Files. If
you wish to create more than one account file, for example to keep track of a
credit card account which is separate from your bank account, you can use the
New command in the File menu to create a new account file. You can then load
your different account files using the Open File command, though the program
only allows you to see one account file at a time).
If you are only using a single account with only one set of transactions, you will
never need to use the New or Open commands, or worry about files.

Transaction Listing and Numbering
"Cheques" and "Other Withdrawals"

When adding or editing a withdrawal transaction, you can choose to make it a
"Cheque" or an "Other Withdrawal". The difference between these lies in the
transaction reference numbering,

"Cheque" transactions are always numbered, and the program will work best if
you make the Cheque reference numbers in the program match the numbers
printed on the actual cheques you write. Every time you enter a new cheque
transaction, the program automatically checks the reference number of the last
cheque transaction you entered, and suggests the next number in sequence for the
new transaction.

"Other Withdrawal" transactions do not have to be numbered, but if you do
choose to number them (see Set Preferences), their numbers will have a separate
sequence from the "Cheque" transaction numbers. This ensures that the cheque
numbers remain contiguous even if you add some Other deposit transactions as
well.

The Transaction List
The order in which the transactions appear in the list on the main program screen
depends solely on the order in which you enter them. The transaction reference
number and date do not affect the position in which the transaction appears in the
list.
When you use the Add command, the new transaction is always Added to the
end of the list. If you want to add a new transaction in the middle of the list,
move the selection highlight to the position in the list where you want to insert a
transaction, then use the Insert Transaction command.
If you want to Move a transaction to a different position in the list, you can do
this using the Delete and Insert commands - see Delete Transaction on page 19
for more information.

Amstrad PCWI16 Page ||



Account Manager

Viewing and Printing Information
Although the main program screen lists all the transactions in your account, there
are a number of other ways in which you can display or print the information
stored in your Account Manager program.

Viewing the Cheque Book
The File menu contains a View Cheque-Book command, which provides a
complete summary of all the transactions you have entered into the program, and
allows you to print this summary on your printer. When you select this com-
mand, the program offers you these options:

List All or from current List selection?

) ) ey

The All option displays the entire account, while the List option shows only those
transactions dated after the currently selected transaction. (Remember that the
"current transaction"” is the one which is highlighted in the main program screen.)

Viewing The Bank Balance - "Received" and "Not Received"
The Bank Balance display is similar to the Cheque-Book display explained
above, but with one important difference - it ignores transactions which are not
marked as “Received”, leaving them out of the list, and omitting them from any
balance calculations. The “Not Received” option allows you to enter cheques on
the day they are deposited or written, then when you receive confirmation that
the funds have actually cleared (eg a bank statement), you can use the Edit
command to change the option to “Received” (or just click on the transaction
with the mouse right button). Using this system, you can be sure that your bank-
balance shows only those funds which you know have been cleared.
As with the View Cheque-Book command described earlier, you can choose to
list All transactions, or only those transactions after and including the transaction
which is currently selected.

Printing
There are also two Print commands, for the Cheque-Book and Bank Balance
respectively. These work in exactly the same way as the View commands
described above, but print the transaction information on paper instead.

Showing Expenditure By Category

For information about displaying and printing information according to catego-
ries, see Using Transaction Categories on page 16.
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Standing Transactions

As well as the transactions you enter individually, you can also make the pro-
gram automatically enter transactions which happen at regular intervals, such as
standing orders or direct salary payments. Automatic regular transactions are
called Standing Transactions.

To set up standing transactions, you must use the Edit Standing Transactions
command in the Edit menu. Selecting this command with a new account displays
the following dialog:

I

To add a new Standing Transaction, click the Add New Transaction button.
This displays a dialog which lets you enter details of the Standing Transaction.
This example shows an entry for an insurance premium payment of £25.42, made
once a month:

The Memo, Category and Amount seftings are the same as for any normal
transaction.

The Date is that of the first occurrence of the transaction. Future transactions
occur from that date, as controlled by the Rate setting.

The Rate setting controls how often the Standing transaction is made - you can
set this to Weekly, Monthly, Quarterly, Semi-Annually (every six months),
and Annually, according to the type of transaction.
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The Pay Period is the total number of payments which must be made. This is
useful for setting up credit purchases, where the standing transaction happens a
fixed number of times, then ceases. For example, if you set up a transaction with
the Rate set to Monthly and the Pay Period to 6, the transaction will automati-
cally be processed six times at one-month intervals, then cease.

If you set the Pay Period option to “9999”, the default setting, the transaction is
repeated indefinitely.

Processing Standing Transactions
Whenever you run the Account Manager program, or set up new Standing
transactions, the program automatically checks to see if any Standing Transac-
tions are due - in other words, whether any regular payments should have
happened since the last time the program was run. If the program detects that it
should process any Standing transactions, it displays a message asking you
whether you want the transaction(s) to be processed:

Thars are Standing Transactions due,

Procaes them now?

=9 =)

If you answer Yes, the transaction(s) will be processed. If you answer No, they
will not be processed, but they will remain pending, and the next time you run
the program, you will again be asked if you want to process them.

Important Note: once an occurrence of a Standing Transaction has been proc-
essed, that occurrence is stored in the account just like a normal transaction. This
means that you can change the details of a particular occurrence of a Standing
Order after it has been processed, without affecting any other occurrences of that
Standing Order. Likewise, if you use the Edit Standing Transactions command
to alter the settings of the Standing Order, this will not affect or change any
occurrences of that Standing Order which have already been processed.

Removing A Standing Transaction
To remove a Standing Transaction, select the Edit Standing Transactions
command in the Edit menu, select the transaction you want to delete from the list
shown in the dialog, and click the Delete button. Note that this does not delete
any occurrences of the transaction which have already been processed.

Editing A Standing Transaction
In addition to Adding and Deleting a Standing Transaction, you can also Edit an
existing one, by clicking the Edit a Transaction button. This button displays a
dialog which lets you change any of the details for the standing transaction.
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Note that changing the settings for a Standing Transaction will not affect the
settings for any transactions which have already been processed, as explained in
Processing Standing Transactions opposite. For example, when you choose to
Edit a Standing Transaction, the editing dialog shows the transaction "Pay Date"
as the next transaction which is due in the future, NOT the Pay Date you typed
when you first entered the Standing Transaction. It is important to understand
that an occurence of a Standing Transactions which has already been processed
can then be edited or deleted in just the same as any other one-off transaction.

Standing Transactions and Real Bank Accounts
Regular transactions in a real bank account might be any of the following types:
Regular Deposits, such as the payment of wages or other transfers directly
into the account;
Direct Debits, where you pay regularly, but the amount may vary;
Standing Orders, where you pay the same amount every time.
All the Standing Transactions in Account Manager behave like Standing Orders -
you enter an amount when you set up the Standing transaction, and that amount
is always used unless you alter it.
However, if you want to use the Standing Transaction feature to enter Direct
Debits, or regular but varying Deposits, there is no reason why you shouldn't.
The system will work perfectly well, as long as you make sure that whenever a
Standing Transaction of this type is processed, you check the amount with your
real bank statement. If the amount for a particular transaction is wrong, you can
use the Edit Transaction command to enter the correct amount for that particu-
lar occurrence of the transaction.
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Using Transaction Categories

All transactions have a "Category" setting, which allows you to categorise your
income and outgoings, and to see totals for specific categories and combinations
of categories. When you first use the program, you will see that some categories
are pre-defined, but you can always change or delete these, or add new categories
of your own. For example, the pre-defined categories for Withdrawal transac-
tions include Insurance, Car, Mortgage/Loans, Credit Card, Bills/Services
and others, but you may want to add other categories of your own, such as TV
Licence or Child-Care.

Adding a New Category
You can alter the Categories using the Edit Categories command in the Edit
menu. When selected, this command asks you to choose whether you want to
edit the Withdrawal or Deposit categories, then shows you a list of the categories
which currently exist, with command buttons for altering them or adding new
ones.
For example, let's assume that you want to create a new Withdrawal category, for
payments for child-care. After choosing the Edit Categories command, then
selecting Withdrawal categories, you will see the following dialog:

il car

||Mortgage/Loans SR
il Bills /Services
|' | Insurance
Il Pension
.||E Miscellaneous

||| redi ard
"'. Supermarket
(|

it

If you click the Add New Category button, you can type in the name for your
new category - in this case, Child Care - then click the Store button.
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The categories list now looks like this:

~ EDIT WITHDRAWAL CATEGORIES

Select a category and press Rename or Dele
Add New Catego

..with the Child Care category highlighted. Whenever you add or edit a transac-
tion, you can now use the new category.

Other Category Features - Renaming and Deleting
As well as adding new categories, you can also change the name of a category
using the Rename button, or Delete a category altogether using the Delete
button.
Important Notes on Deleting Categories: although you can Delete a category
which is not being used, you cannot delete a category which has is being used by
a transaction. If you want to delete a category which is in use, you must first
ensure that no transactions are using the category, and if they are, you must
change the category setting of these transactions using the Edit Transaction
command for each one.
The program will also stop you from deleting the first two categories in either the
Deposit or Withdrawal category lists, though you can Rename these categories as
described above.

Categories and Folders
If you do want to use more than one account file, you should bear in mind that
the Categories used by the Account Manager program (see page 16) are stored
separately from the account file which contains the transactions, but the program
stores the two files in the same folder. If you want to use the same categories for
all your account files, you can store them all in the same folder, but if you want
to have separate category lists for the different account files you create, you must
store the files in separate folders.
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Analysing Transactions Using Categories
If you want to see a summary of all the transactions in a single category, or a
combined summary of several categories, you can use the List By Categories
command in the File menu. The command displays a list of all the categories, for
both Deposits and Withdrawals, and you can select any category by clicking on
its name in the list. You can also de-select a selected category by clicking on it
again, so you can choose any combination of categories to list.
You can also choose to display the list on the screen, or print it on your PcW16
printer, by clicking the List to Screen orList To Printer box:

When you have selected the categories you want to list, click the List button or
press Green to display the transactions. This example shows a list of all the
transactions in the categories which were selected in the previous illustration:

* * Category Listing * *

Number Date Memao Amount Balance
002030 16/01/4997 Credit Card Dec -56.07 -56.07
002031 26/01/1997 Shopping -46.63 -102.70
002032 14/02/1997 Credit Card Jan -235.34 -338.04
002033 24/02/13387 Shopping -§9.94 -427.98

28/02/1987 MNursery (5) -25.80 -453.78
002034 414/03/41987 Credit Card Feb -651.36 -1105.14
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Command Reference
This chapter lists the program commands in alphabetical order.

Add New Transaction (Edit Menu)
This command adds a new transaction to the account - see Your First Transac-
tion, page 3, for details.

Delete Transaction (Edit Menu)
This command deletes the currently selected transaction from the account, and
recalculates the balance accordingly. Note that if you Delete a transaction by
mistake, you can Undo the Delete command to restore the transaction.

Moving Transactions using Delete and Insert

When you Delete a transaction, it is not removed altogether, but placed in
temporary storage, rather like the Clipboard feature in the PcW16's word-
processor program. To Move a transaction to a different position in the list,
follow these steps:

Use the T\ keys to select the transaction you want to move;

Delete the Transaction using the Delete Command;

Use the T4 keys to move the highlight to the position in the list to where you
want to move the transaction;

Use the Insert Transaction command to insert the deleted transaction at the new
position in the list.

Remember that you must not use any other commands in between the Delete and
Insert commands.

Delete All (Edit Menu)

This command clears the entire account, and all the information is lost.

Edit Categories (Edit Menu)
This command allows you to Add, Delete or Rename the categories for both
Deposit and Withdrawal transactions - see Using Transaction Categories,
page 16, for details.

Edit Standing Transactions (Edit Menu)
This command allows you to add, alter or remove Standing Transactions from
your account. For a full explanation of Standing Transactions, see page 13.

Edit Transaction (Edit Menu)
This command allows you to alter the details or settings of any transaction in the
account file. See Editing Transactions on page 9 for more information.
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Exit (File Menu)
This command ends the Account Manager program, and returns to the PcW16
Desktop. If you have modified the current file but you have not yet saved the
modified file, the program will ask you if you want to save before you quit.

Export (File Menu) see Import
Find (Edit Menu)

This command allows you to search through the current account file for a
particular word, or any sequence of characters or figures. When selected, the
command displays the following dialog:

If you type the text or number you want to find, then click the FIND button, the
program will search through from the beginning of the account file, and highlight
the first transaction it finds which contains the data you want to Find.

Extra FIND Features

FIND NEXT
Once you have completed a Find command, you can then find the next occur-
rence of the text or number you entered, simply by pressing [Task]+[A].

Finding Memos by Initial Letter

You can also find transactions without using a command at all. In the main
program screen, if you simply type a letter on the keyboard, the program will
find the next transaction whose Memo begins with that letter. The search begins
at the currently selected transaction, and begins again from the top of the account
file if there are no matching transactions after the current selection.

Finding '"Not Received' Transactions

As well as the Initial Letter search, when no command is selected, you can also
search for "Not Received" transactions, by pressing [Task]+[X]. Like the initial
letter search, this search begins at the current selection, and works forwards.
Pressing [Task]+[X] repeatedly moves through all the "Not Received" transac-
tions.
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Import and Export (File Menu)
These commands allow you to import and export transactions from other compu-
ter systems such as PC-compatibles. The Import and Export commands use a
CSV (“comma-separated value™) file format. These features are intended for use
only by those who are familiar with computer data-file structures - do not try to
import data into your Account Manager program unless you are sure that
you know what you are doing, and always take a backup of your account file
before trying to import.
To see the layout of the CSV files which can be used by the program, enter some
transactions, then use the Export command to create a CSV file, and examine the
contents of file.

Insert Transaction (Edit Menu)
This command works like the Add Transaction command, but instead of adding
a new transaction to the end of the list, it inserts a transaction before the one
which is currently selected in the list. See Adding a New Transaction on page 7
for more information about adding new transactions.
Note on Insert and Delete
If you have Deleted a transaction, then you select Insert, the details of the
deleted transaction can automatically be used in the Insert dialog, though you can
change these details and add different ones if you wish.
You can also use this feature of the Insert and Delete commands to Move a
transaction from one place to another in the list - see Delete Transaction on
page 19 for more information,

Install to Cabinet (File Menu)
This command copies the various files used by the Account Manager program
into the Cabinet. If you install the program in the Cabinet, you can use the Run
External Program command to run Account Manager without needing to insert a
floppy disc.
The Install dialog displays a Folder drop-list, which you can use to choose the
Cabinet folder in which you want to store the program and its files. To change
folder, click on the drop-list arrow, then click on the folder you want.
If you have already used the Account Manager program and created one or more
cheque-book files on your floppy disc, the dialog also allows you to choose
which of these files you want to copy to the Cabinet. To select an account file
for copying, click on the file name in the list to highlight it, or the T keys to
move the cursor over the name of the file and press [Space] to select it. Only
highlighted files are copied into the Cabinet along with the program. If the list
shows the message <<No Files>>, you can ignore it.
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List By Categories (File Menu)
Each transaction has a Category, and this command allows you to select one or
more categories, and list all the transactions in them on the screen or on your
printer. The list includes a total balance for the categories selected. See Using
Transaction Categories, page 16, for more information.

New (File Menu)
This command starts a new account file. There are two situations in which you
may want to do this:
If you want to start a completely new set of financial records;
If you want to start a new file for a new year, but using the existing categories
and transactions for an account file which already exists. Important note: it is
only possible to create a continuation file from an account file which is already
loaded into the program. If you want to create a continuation file, you must first
load the old file, then choose the New command.
The New command displays a box asking you to enter a name for the new
account. When you have typed in the name (at the same time, you can also
choose to store the new file in the Cabinet or on floppy disc), the program
displays this question:

Craats an ampty fs or & continuation flle?.

) e ()

If you want to start a completely new account file, choose the Empty button. If
you want to create a new file which is a continuation of the last account file you
loaded, choose the Continuation button.

Open (File Menu)
This command opens an existing account file. It lets you choose a file from any
folder in the cabinet or on floppy disc.
If you only use one account file, you can set it up as the “Startup File”, so that it
loads automatically whenever the program is run. This means that you will not
normally have to use the Open command at all.

Print Cheque-Book and Print Bank-Balance (File Menu)
These commands are the same as the View commands (see page 25), but instead
of displaying the Cheque-Book and Bank Balance information on the screen,
they print it. There are a number of options you can change to control the
printing - see Preferences on page 24.
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Process Standing Transactions (Edit Menu)
Standing Transactions are transactions which are programmed to occur at regular
intervals - see Standing Transactions on page 13 for more information.

Automatic Processing

When you start Account Manager program, it checks to see if any occurrences of
Standing Transactions are due, and if so, it asks you if you want to process them,
or in other words, to add them to the account file. If you answer NO to this
question, the pending transactions are not processed, but are stored, and the
program will remember that they are due, so that next time you start the program,
it will ask you again if you want to processes them.

Using the Process Standing Transactions Command

If you choose not to process the transactions which are due when the program
starts, you can use this command to process them later. If no Standing Transac-
tions are pending, the command is not available.

Reload File (File Menu)
This command simply reloads the currently loaded account file. By reloading
the file, the program restores the last-saved version of the file, removing any
changes you have made since the file was last loaded.

Save As (File Menu)
This command saves the current account file, but lets you enter a different name
for it. If you enter a different name, the program creates a new copy of the file
under the new name. The old copy of the file is not deleted, but remains stored
under its original name, and can be loaded using the Open command if required.

Save (File Menu)
This command saves the current file, using its existing name. It is a good idea to
save your work every few so often when using any kind of computer system.

Set All Received (Edit Menu)

This command sets all the transactions in the account to "Received", so that both
the Bank Balance and the account balance show the same figure.
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Set Preferences (Options Menu)
The Preferences dialog lets you set some options for the way you want the
program to work. The settings of these options are stored when you change
them, and always re-implemented when the program is re-run later.

Print Transaction Numbers

When using the Print commands for the Cheque-Book or the Bank Balance, this
option allows you to choose whether or not to include the "Transaction Num-
bers". The transaction numbers simply show the order in which the transactions
appear in the on-screen list - the first transaction in the list is No.1, the next is
No.2, and so on, and the numbers are shown at the far left of the display:

* * Bank Balanca * *

Mumber Date Memo Amount Balance
1. D 01/04/1987 Starting Balance +569.35 569.35
2. 16/04/1997 Mortgage (5) -265.76 303.59
3. 002030 416/01/1997 Credit Card Dec =56.07 247.52
4, 0D20341 28/01/1387 Shopp -45.63 200.8%
5 D 05/02/1997 Wages (5) +856.00 1056.83
B. 14 /02/41997 Car Insurance (5) -22.40 1034.43

Note that these transaction numbers are not the same as the cheque or
reference numbers you enter for each transaction - the reference numbers are
always displayed in the View and Print commands, and are displayed beside the
Date, as shown above.

Print Categories
When printing, this option lets you choose to include each transaction's Category
name.

Print Mode
The printing commands can operate in Draft or Fine mode - Draft is faster, but
Fine produces better print quality.

Number Cheques Only / All Transactions

This command only affects the automatic addition of numbers to each new
transaction you add. When entering a new cheque transaction, you will find that
the cheque-number is entered in the dialog for you automatically, but with the
"All Transactions" option selected, all cash withdrawal and all deposit transac-
tions will also be allocated numbers automatically.

Note that these numbers are separate from the "Transaction Numbers"
described under Print Transaction Numbers above - the number you give a
transaction when entering it is your own reference number for that transaction,
and does not have any connection with the transaction's position in the list.
For more information about Transaction numbers, see page 11.
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Prompt Before Saving

The program will Save your file automatically when you exit, or when you Open
another file. This option forces the program to display a Confirmation dialog
before any file is saved automatically, so that you can abort the Save if you wish.

Set Startup File (File Menu)
When you run the Account Manager program, it will automatically Open the last
account file you were using. If you do not want this to happen, you can use this
command allows you to select a particular account file for automatic loading at
startup.
If you are only using a single account file, you do not need to use this command,
as the file will be Opened automatically anyway.

Set Transaction Received (Edit Menu)
When each transaction is entered, it can be marked as "Received" or "Not
Received", as described in Viewing The Bank Balance on page 12.
This command allows you to set the currently selected transaction to Received,
and the program will then automatically update the bank balance accordingly.
You can also set an Unreceived transaction to Received by clicking on it with the
mouse right button in the program's main transaction list.

Show Not Received (File Menu)
This command displays a list of the transactions which are marked as “Not
Received”, and shows their total value.

View Bank Balance (File Menu)
This command displays a list on the screen of all the transactions which have
been Received, together with the total balance for Received transactions. It
ignores transactions which have not been marked as Received.
Instead of listing all the transactions, you can choose to list from the currently
selected transaction onwards. For more information, see Viewing and Printing
Information on page 12.

View Cheque-Book (File Menu)
This command provides a screen display of the transactions in the account. You
can choose to list all the transactions, or list from the currently selected transac-
tion onwards. For more information, see Viewing and Printing Information on
page 12.

=
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